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 Alcatel License Agreement

SAMPLE END USER LICENSE AGREEMENT

1. LICENSE
1.1 Subject to the terms and conditions of this Agreement, Alcatel grants to 

Customer and Customer accepts a non-exclusive, non-transferable license to use 
any software and related documentation provided by Alcatel pursuant to this 
Agreement ("Licensed Program") for Customer's own internal use,  solely in 
conjunction with hardware supplied or approved by Alcatel.  In case of 
equipment failure, Customer may use the Licensed Program on a back-up 
system, but only for such limited time as is required to rectify the failure.

1.2 Customer acknowledges that Alcatel may have encoded within the Licensed 
Program optional functionality and capacity (including, but not limited to, the 
number of equivalent nodes, delegate work stations, paths and partitions), which 
may be increased upon the purchase of the applicable license extensions.

1.3 Use of the Licensed Program may be subject to the issuance of an application 
key, which shall be conveyed to the Customer in the form of a Supplement to this 
End User License Agreement. The purchase of a license extension may require 
the issuance of a new application key.

2. PROTECTION AND SECURITY OF LICENSED PROGRAMS
2.1 Customer acknowledges and agrees that the Licensed Program contains 

proprietary and confidential information of Alcatel and its third party suppliers, 
and agrees to keep such information confidential.  Customer shall not disclose 
the Licensed Program except to its employees having a need to know, and only 
after they have been advised of its confidential and proprietary nature and have 
agreed to protect same.

2.2  All rights, title and interest in and to the Licensed Program, other than those 
expressly granted to Customer herein, shall remain vested in Alcatel or its third 
party suppliers.  Customer shall not, and shall prevent others from copying, 
translating, modifying, creating derivative works, reverse engineering, 
decompiling, encumbering or otherwise using the Licensed Program except as 
specifically authorized under this Agreement.  Notwithstanding the foregoing, 
Customer is authorized to make one copy for its archival purposes only.  All 
appropriate copyright and other proprietary notices and legends shall be placed 
on all Licensed Programs supplied by Alcatel, and Customer shall maintain and 
reproduce such notices on any full or partial copies made by it.

3.  TERM
3.1 This Agreement shall become effective for each Licensed Program upon 

delivery of the Licensed Program to Customer.
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3.2 Alcatel may terminate this Agreement: (a) upon notice to Customer if any 
amount payable to Alcatel is not paid within thirty (30) days of the date on which 
payment is due; (b) if Customer becomes bankrupt, makes an assignment for the 
benefit of its creditors, or if its assets vest or become subject to the rights of any 
trustee, receiver or other administrator; (c) if bankruptcy, reorganization or 
insolvency proceedings are instituted against Customer and not dismissed within 
15 days; or (d) if Customer breaches a material provision of this Agreement and 
such breach is not rectified within 15 days of receipt of notice of the breach from 
Alcatel. 

3.3 Upon termination of this Agreement, Customer shall return or destroy all copies 
of the Licensed Program.  All obligations of Customer arising prior to 
termination, and those obligations relating to confidentiality and non-use, shall 
survive termination.

4.  CHARGES
4.1 Upon shipment of the Licensed Program, Alcatel will invoice Customer for all 

fees, and any taxes, duties and other charges.  Customer will be invoiced for any 
license extensions upon delivery of the new software application key or, if a new 
application key is not required, upon delivery of the extension. All amounts shall 
be due and payable within thirty (30) days of receipt of invoice, and interest will 
be charged on any overdue amounts at the rate of 1 1/2% per month (19.6% per 
annum).

5.  SUPPORT AND UPGRADES
5.1 Customer shall receive software support and upgrades for the Licensed Program 

only to the extent provided for in the applicable Alcatel software support policy 
in effect from time to time, and upon payment of any applicable fees.  Unless 
expressly excluded, this Agreement shall be deemed to apply to all updates, 
upgrades, revisions, enhancements and other software which may be supplied by 
Alcatel to Customer from time to time.

6.  WARRANTIES AND INDEMNIFICATION
6.1 Alcatel warrants that the Licensed Program as originally delivered to Customer 

will function substantially in accordance with the functional description set out 
in the associated user documentation for a period of 90 days from the date of 
shipment, when used in accordance with the user documentation.  Alcatel's sole 
liability and Customer's sole remedy for a breach of this warranty shall be 
Alcatel's good faith efforts to rectify the nonconformity or, if after repeated 
efforts Alcatel is unable to rectify the non-conformity, Alcatel shall accept return 
of the Licensed Program and shall refund to Customer all amounts paid in 
respect thereof.  This warranty is available only once in respect of each Licensed 
Program, and is not renewed by the payment of an extension charge or upgrade 
fee.
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6.2 ALCATEL EXPRESSLY DISCLAIMS ALL OTHER WARRANTIES, 
REPRESENTATIONS, COVENANTS OR CONDITIONS OF ANY KIND, 
WHETHER EXPRESS OR IMPLIED, INCLUDING WITHOUT 
LIMITATION, WARRANTIES  OR REPRESENTATIONS OF 
WORKMANSHIP, MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE, DURABILITY, OR THAT THE OPERATION OF THE 
LICENSED PROGRAM WILL BE ERROR FREE OR THAT THE 
LICENSED PROGRAMS WILL NOT INFRINGE UPON ANY THIRD 
PARTY RIGHTS.

6.3 Alcatel shall defend and indemnify Customer in any action to the extent that it is 
based on a claim that the Licensed Program furnished by Alcatel infringes any 
patent, copyright, trade secret or other intellectual property right, provided that 
Customer notifies Alcatel within ten (10) days of the existence of the claim, 
gives Alcatel sole control of the litigation or settlement of the claim, and 
provides all such assistance as Alcatel may reasonably require.  Notwithstanding 
the foregoing, Alcatel shall have no liability if the claim results from any 
modification or unauthorized use of the Licensed Program by Customer, and 
Customer shall defend and indemnify Alcatel against any such claim.

6.4 Alcatel Products are intended for standard commercial uses.  Without the 
appropriate network design engineering, they must not be sold, licensed or 
otherwise distributed for use in any hazardous environments requiring fail safe 
performance, such as in the operation of nuclear facilities, aircraft navigation or 
communication systems, air traffic control, direct life support machines, or 
weapons systems, in which the failure of products could lead directly to death, 
personal injury, or severe physical or environmental damage.  The Customer 
hereby agrees that the use, sale, licence or other distribution of the Products for 
any such application without the prior written consent of Alcatel, shall be at the 
Customer's sole risk.  The Customer also agrees to defend and hold Alcatel 
harmless from any claims for loss, cost, damage, expense or liability that may 
arise out of or in connection with the use, sale, licence or other distribution of the 
Products in such applications.

7.  LIMITATION OF LIABILITY
7.1 IN NO EVENT SHALL THE TOTAL COLLECTIVE LIABILITY OF 

ALCATEL, ITS EMPLOYEES, DIRECTORS, OFFICERS OR AGENTS FOR 
ANY CLAIM, REGARDLESS OF VALUE OR NATURE, EXCEED THE 
AMOUNT PAID UNDER THIS AGREEMENT FOR THE LICENSED 
PROGRAM THAT IS THE SUBJECT MATTER OF THE CLAIM.  IN NO 
EVENT SHALL THE TOTAL COLLECTIVE LIABILITY OF ALCATEL, 
ITS EMPLOYEES, DIRECTORS, OFFICERS OR AGENTS FOR ALL 
CLAIMS EXCEED THE TOTAL AMOUNT PAID BY CUSTOMER TO 
ALCATEL HEREUNDER.  NO PARTY SHALL BE LIABLE FOR ANY 
INDIRECT, SPECIAL OR CONSEQUENTIAL DAMAGES, WHETHER OR 
NOT SUCH DAMAGES ARE FORESEEABLE, AND/OR THE PARTY HAD 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

7.2 The foregoing provision limiting the liability of Alcatel's employees, agents, 
officers and directors shall be deemed to be a trust provision, and shall be 
enforceable by such employees, agents, officers and directors as trust 
beneficiaries.
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8.  GENERAL
8.1 Under no circumstances shall either party be liable to the other for any failure to 

perform its obligations (other than the payment of any monies owing) where 
such failure results from causes beyond that party's reasonable control.

8.2 This Agreement constitutes the entire agreement between Alcatel and Customer 
and supersedes all prior oral and written communications.  All amendments shall 
be in writing and signed by authorized representatives of both parties.

8.3 If any provision of this Agreement is held to be invalid, illegal or unenforceable, 
it shall be severed and the remaining provisions shall continue in full force and 
effect.

8.4 The Licensed Program may contain freeware or shareware obtained by Alcatel 
from a third party source.  No license fee has been paid by Alcatel for the 
inclusion of any such freeware or shareware, and no license fee is charged to 
Customer for its use.  The Customer agrees to be bound by any license agreement 
for such freeware or shareware. CUSTOMER ACKNOWLEDGES AND 
AGREES THAT THE THIRD PARTY SOURCE PROVIDES NO 
WARRANTIES AND SHALL HAVE NO LIABILITY WHATSOEVER IN 
RESPECT OF CUSTOMER'S POSSESSION AND/OR USE OF THE 
FREEWARE OR SHAREWARE.

8.5 Alcatel shall have the right, at its own expense and upon reasonable written 
notice to Customer, to periodically inspect Customer's premises and such 
documents as it may reasonably require, for the exclusive purpose of verifying 
Customer's compliance with its obligations under this Agreement.

8.6 All notices shall be sent to the parties at the addresses listed above, or to any such 
address as may be specified from time to time.  Notices shall be deemed to have 
been received five days after deposit with a post office when sent by registered 
or certified mail, postage prepaid and receipt requested.

8.7 If the Licensed Program is being acquired by or on behalf of any unit or agency 
of the United States Government, the following provision shall apply:  If the 
Licensed Program is supplied to the Department of Defense, it shall be classified 
as "Commercial Computer Software" and the United States Government is 
acquiring only "restricted rights" in the Licensed Program as defined in DFARS 
227-7202-1(a) and 227.7202-3(a), or equivalent.  If the Licensed Program is 
supplied to any other unit or agency of the United States Government, rights will 
be defined in Clause 52.227-19 or 52.227-14 of the FAR, or if acquired by 
NASA, Clause 18-52.227-86(d) of the NASA Supplement to the FAR, or 
equivalent.  If the software was acquired under a contract subject to the October 
1988 Rights in Technical Data and Computer Software regulations, use, 
duplication and disclosure by the Government is subject to the restrictions set 
forth in DFARS 252-227.7013(c)(1)(ii) 1988, or equivalent.

8.8 Customer shall comply with all export regulations pertaining to the Licensed 
Program in effect from time to time. Without limiting the generality of the 
foregoing, Customer expressly warrants that it will not directly or indirectly  
export, re-export, or transship the Licensed Program in violation of any export 
laws, rules or regulations of Canada, the United States or the United Kingdom.
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8.9 No term or provision of this Agreement shall be deemed waived and no breach 
excused unless such waiver or consent is in writing and signed by the party 
claimed to have waived or consented.  The waiver by either party of any right 
hereunder, or of the failure to perform or of a breach by the other party, shall not 
be deemed to be a waiver of any other right hereunder or of any other breach or 
failure by such other party, whether of a similar nature or otherwise.

8.10This Agreement shall be governed by and construed in accordance with the laws 
of the Province of Ontario.  The application of the United Nations Convention 
on Contracts for the International Sale of Goods is hereby expressly excluded.
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Preface

 

About this document

The 5620 SAM Routine Maintenance Procedures Guide provides procedures to:

• generate baseline information for 5620 SAM applications
• provide daily, weekly, monthly, and as needed maintenance procedures for 

5620 SAM-managed networks
Alcatel 5620 Service Aware Manager, Release 3.0 R1 ix
October 2005 95-5960-01-00-A



Preface
About related documentation

The following documents provide additional 5620 SAM information.

• Contact your Alcatel support representative for more information about network 
sizing and recommended hardware configurations. Use the 5620 SAM Planning 
Guide for more information about sizing.

• See the 5620 SAM Installation and Upgrade Guide for information about 
installing and upgrading the 5620 SAM database, server, and client software.

• See the 5620 SAM User Guide and 5620 SAM Parameter Guide for information 
about using the client GUI to perform network management functions, including 
descriptions of configurable parameters. 

• See the Alcatel 5620 SAM-O OSS Interface Developer Guide for information 
about using the XML OSS interface to create OSS applications, such as alarm 
monitoring and inventory controls. 

• See the 5620 SAM Troubleshooting Guide for information about how to 
troubleshoot 5620 SAM-managed networks, services, applications and 
platforms.

• Use the 5620 SAM System Architecture Guide to understand how the software 
components are designed.

• Use the 5620 SAM Statistics Management Guide to manage statistics and view a 
list of supported MIB counters that can be collected by 5620 SAM.

• Use the  5620 SAM CNM Developer Guide to create CNM applications.

See the index file in the User Documentation directory on the application DVD for 
additional documentation.

See the 7750 SR and 7450 ESS user documentation guides for more information 
about specific CLI commands, node installation, and parameters information.

Conventions used in this guide

The following table lists the conventions that are used throughout the documentation.

Table 1  Documentation conventions

Convention Description Example

Key name Press a keyboard key Delete

Italics Identifies a variable hostname

Key+Key Type the appropriate consecutive keystroke sequence CTRL+G

Key–Key Type the appropriate simultaneous keystroke sequence CTRL–G

↵ Press the Return key ↵

— An em dash in a table cell indicates there is no information. —

→ Indicates that a cascading submenu results from selecting a 
menu item

Policies→Routing
x Alcatel 5620 Service Aware Manager, Release 3.0 R1
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Preface
Procedures with options or substeps
When there are options in a procedure, they are identified by letters. When there are 
substeps in a procedure, they are identified by roman numerals.

Example of options in a procedure

At step 1, you can choose option a or b. At step 2, you must do what the step 
indicates.

1 This step offers two options. You must choose one of the following:

a This is one option.

b This is another option.

2 You must perform this step.

Example of substeps in a procedure

At step 1, you must perform a series of substeps within a step. At step 2, you must 
do what the step indicates.

1 This step has a series of substeps that you must perform to complete the step. You 
must perform the following substeps:

i This is the first substep.

ii This is the second substep.

iii This is the third substep.

2 You must perform this step.

Important information
The following conventions are used to indicate important information:

Warning —  Warning indicates that the described activity or situation 
may, or will, cause equipment damage or serious performance 
problems.

Caution —  Caution indicates that the described activity or situation 
may, or will, cause service interruption.

Note —  Notes provides information that is, or may be, of special 
interest.
Alcatel 5620 Service Aware Manager, Release 3.0 R1 xi
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1 —  5620 SAM routine maintenance procedures overview
1.1 Maintenance overview

The 5620 SAM Routine Maintenance Procedures Guide is intended for NOC 
operations or other engineering operational staff that are responsible for developing 
and implementing maintenance procedures in 5620 SAM-managed IP/MPLS 
networks.

The 5620 SAM maintenance tasks and procedures are categorized by frequency. 
Alcatel recommends the implementation of a regular maintenance schedule to help:

• prevent downtime caused by software, platform, or network failure
• your 5620 SAM applications operate at maximum performance

The appropriate maintenance frequency depends on the network conditions of the 
individual service provider or operation. Tailor the suggested maintenance actions 
and frequency to the unique needs of your network.

Table 1-1 lists where to find maintenance information.

Table 1-1 Maintenance information

1.2 5620 SAM maintenance guidelines

Use this guide as a basis for developing new or enhancing existing maintenance 
procedures and workflows that are used in the NOC. This guide does not provide a 
complete list of the features and functionality of the 5620 SAM. The guide includes 
a high-level view of maintenance actions based on frequency, suggests baseline 
measures to ensure performance tracking, and describes how to use 5620 SAM 
applications to check performance.

The staff that is responsible for developing or performing 5620 SAM maintenance 
tasks needs a good understanding of:

• creating and interpreting 5620 SAM-O XML requests and responses
• executing 5620 SAM client GUI functions and operations
• the relationship of 5620 SAM software applications, log files, and the plaforms 

on which the applications run

See the other documentation, as described in the Preface, to supplement the 
development of individualized maintenance procedures for your network.

For information about See chapter

Performance maintenance baselines 2

Daily maintenance tasks 3

Weekly maintenance tasks 4

Monthly maintenance tasks 5

As required maintenance tasks 6
1-2 Alcatel 5620 Service Aware Manager, Release 3.0 R1
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1 —  5620 SAM routine maintenance procedures overview
1.3 Obtaining technical assistance

Collect the information listed in Table 1-2 before you call your TAC or technical 
support representative, or use Alcatel web support The list of Alcatel support 
contacts is available from the Alcatel home page at www.alcatel.com. Click on the 
Support link.

Table 1-2 Data collection for support

1.4 5620 SAM maintenance checklist

Table 1-3 is a checklist of the recommended 5620 SAM maintenance tasks.

Table 1-3 Recommended 5620 SAM preventive maintenance tasks

Action Collect the following

Collect software and platform 
information

• release version and load of 5620 SAM software
• Solaris, Linux, or Windows operating system version 

and patch set
• platform information, including CPU, disk, and RAM data

Collect any applicable software logs • The appropriate log files from the PC or workstation 
where the issue occurred. For example, for server 
maintenance issues, retrieve the EmsServerLog.txt file 
from the install directory log directory or folder.

Collect information about actions 
performed

• if appropriate, screen captures or a text version of any 
messages or logs

• an inventory of the actions, for example, the GUI 
configurations performed before the issue occurred

• any troubleshooting actions and the results

✓ Maintenance task Purpose See section

Daily maintenance tasks

Managing alarms • Track and handle incoming alarms.
• Log historical logs for record keeping.

3.1

Verifying device synchronization Ensure consistency between 5620 SAM and managed 
devices.

3.2

Scheduling a database backup Prevent the loss of network data. 3.3

Collecting and storing system and log 
files

Record historical system activities and current 
configuration settings.

3.4

Backing up NMS domain platforms Back up an entire platform to ensure that all data can be 
restored.

3.5

Weekly maintenance tasks

Verifying performance statistics 
collection

Ensure that there is sufficient capacity to process and 
store network statistics.

4.1

(1 of 2)
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1 —  5620 SAM routine maintenance procedures overview
Gathering inventory data for device 
base performance checks

Collect inventory information for future baseline checks 
and post processing of equipment trends and use.

4.2

Testing 5620 SAM database restores Ensure that database backups are viable in the event 
that a restore is required.

4.3

Checking scheduled device backups Ensure that managed device configuration backups are 
stored and collected correctly if a restore is required.

4.4

Monthly maintenance tasks

Generating and storing a user 
account list

Keep up-to-date records of staff and their assigned user 
accounts.

5.1

Verifying documentation and support 
contact list updates

Check for product updates and new load information. 5.2

Setting the time and date Keep network devices and the NMS domain on the same 
clock.

5.3

Checking Windows PC platform 
performance

Compare PC performance over time to check for 
degradation.

5.4

Checking Solaris workstation platform 
performance

Compare workstation performance over time to check for 
degradation.

5.5

Checking LAN TCP/IP connections 
between network management 
domain elements

Test connectivity between the 5620 SAM platforms. 5.6

As required maintenance tasks

Listing subscriber service information Record subscriber service inventory information. 6.1

Increasing disk space Add swap space on Solaris platforms. 6.2

Checking for duplicate service or 
resource names

Check for duplicate names to ensure naming 
conventions are followed.

6.3

✓ Maintenance task Purpose See section

(2 of 2)
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2 — 5620 SAM maintenance base 
measures

2.1 Base measures overview 2-2
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Alcatel 5620 Service Aware Manager, Release 3.0 R1 2-1
October 2005 95-5960-01-00-A



2 —  5620 SAM maintenance base measures
2.1 Base measures overview

Maintenance base measures can be used by NOC operations or engineering staff that 
are responsible for maintenance issues to evaluate the activity and performance of 
network components, for example, client GUI response times when listing 
equipment.

The data from a series of base measures can be used, over time, to track performance 
trends. For example, if there are complaints that client GUI response times for listing 
equipment degrading over time, you can use the base measures to determine how 
much performance has degraded. The procedures in this guide can help narrow the 
search for the cause of performance degradation.

You should:

• determine the types of base measures that should be implemented for your 
network

• record base measures data
• create and regularly perform the tasks necessary to gather and compare base 

measures over time

This chapter provides base measure information for:

• PC or workstation base measures — to ensure system sizes are tracked
• performance and scalability base measures — to categorize system limitations as 

a baseline against NMS response times
• inventory count base measures — to generate inventory lists for storage and 

post-processing
• billing base measures — to verify whether device accounting and performance 

statistics are collected within properly configured intervals
• reachability base measures — to ensure that customer services are available

2.2 Base measures guidelines

Base measures can be affected by issues that are beyond the scope of this guide, 
including:

• network topology design
• NOC or operations area LAN design

PC or workstation base measures

You can use 5620 SAM PC or workstation base measures to:

• record the details of the PC or workstation
• track network-specific growth to provide a delta for performance measures, for 

example, how long it takes to list 1000 ports on the current PC or workstation 
compared to 10000 ports on the same PC or workstation, or on a smaller or larger 
PC or workstation

You can use Table 2-1 to record 5620 SAM PC or workstation size.
2-2 Alcatel 5620 Service Aware Manager, Release 3.0 R1
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2 —  5620 SAM maintenance base measures
Table 2-1 PC or workstation base data

Application Details of PC or workstation in the NOC

Windows 

5620 SAM database RAM:

CPU (type and speed):

OS:

Disk space:

5620 SAM server RAM:

CPU (type and speed):

OS:

Disk space:

5620 SAM client GUI RAM:

CPU (type and speed):

OS:

Disk space:

Monitor:

Graphics card:

Windows or Linux

Additional client GUIs RAM:

CPU (type and speed):

OS:

Disk space:

Monitor:

Graphics card:

Additional client GUIs RAM:

CPU (type and speed):

OS:

Disk space:

Monitor:

Graphics card:

Solaris

5620 SAM database RAM:

CPU (type and speed):

OS:

Swap:

Database disk file systems:

Disk slice sizes:

5620 SAM server RAM:

CPU (type and speed):

OS:

Swap:

Disk slices:

(1 of 2)
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2 —  5620 SAM maintenance base measures
Inventory base measures

You can use inventory base measures to:

• create lists of network objects for future processing
• track network-specific growth to provide a delta for any performance measures, 

for example, how long it takes 5 versus 15 client GUIs to list 1000 ports

Table 2-2 indicates some inventory base measures that can be used to baseline 
network performance for some commonly performed NOC tasks.

Table 2-2 Inventory base measure

5620 SAM client GUI RAM:

CPU (type and speed):

OS:

Swap:

Disk slices:

Monitor:

Graphics card:

Additional client GUI RAM:

CPU (type and speed):

OS:

Swap:

Disk slices:

Monitor:

Graphics card:

Additional client GUI RAM:

CPU (type and speed):

OS:

Swap:

Disk slices:

Monitor:

Graphics card:

Application Details of PC or workstation in the NOC

(2 of 2)

Type of base 
measure

System limits Response time Network base 
measure

Additional 
information

Client GUI list • 5000 
subscriber 
services

• 5000 services
• 10000 FIB and 

ACL entries
• 50000 logs

Measure the response time 
after you configure the 
NMS LAN for your NOC. 
Record how long it takes to 
perform listing tasks.

When you list more 
than the recommended 
number of objects, 
performance of all 
5620 SAM applications 
is affected.
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Use the following sequence to create inventory base measures, for example, for 
access ports. You can modify the sequence to create additional inventory base 
measures for other objects.

1 Determine the type of object data you want to create inventory records of, for 
example, access ports.

2 List the ports of all managed network devices using the client GUI equipment 
manager or create an XML OSS request to generate the list.

3 Format the inventory for future processing, based on your inventory processing 
applications.

4 Generate the inventory data, using the same listing and filtering criteria, on a 
weekly or monthly basis, as necessary to track changes to the network.

When new devices are added to the network on a regular basis, increase the 
inventory frequency.

5 Use the generated list to record the current inventory of network objects and as 
a baseline measure of performance.

For example, baseline the time required to generate a client GUI list of access 
ports for a device with 100 ports.

When an access port list is later generated, record the time required to generate 
that same list with 100 or 200 ports. Does it take more than two times as long to 
generate a list of 200 ports.

Performance and scalability base measures

You can use the following 5620 SAM performance and scalability base measures to:

• record the system limit numbers and compare to the measurement data collected 
in your network

• track network-specific growth to provide a delta for any performance measures 
on similarly-sized platforms, for example, how long it takes to discover 10 new 
devices versus 20 new devices

• quantify user perceptions of performance

Table 2-3 indicates some scalability base measures that can be used to baseline and 
record scalability data.
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Table 2-3 Scalability base measures

Performance base measures

For networks, commonly available tools such as ping, which measures round trip 
time using ICMP, can be used to determine quantities such as packet loss and round 
trip delay. See the ping command information in this guide, and the 5620 SAM 
Troubleshooting Guide, for more information about performing the commands.

• Packet loss is defined as the fraction of packets sent from a measurement agent to 
a test point for which the measurement agent does not receive an 
acknowledgement from the test point. Acknowledgements that do not arrive 
within a predefined round trip delay at the measurement agent are considered lost.

• Round trip delay is defined as the interval between the time a measurement agent 
application sends a packet to a test point and the time it receives 
acknowledgement that the packet was received by the test point.

You can baseline the packet loss results and round trip delay times for specific NMS 
LAN and network scenarios. Record those results for future baselines against 
regularly run packet loss and round trip delay tests.

Type of base 
measure

System limits Expected response time Network base 
measure 
response time

Additional 
information

Total devices 
managed

See the 
appropriate 
Release 
Description for the 
system limits for a 
release.

The client GUI is 
operational 30 s after 
launching.

The time to open icons 
in the Equipment 
navigation tree 
increases depending 
on the number of 
configured MDAs.

Total services • XML OSS 
configuration of 1000 
VLL services in 33 min

• XML OSS 
configuration of 100 
VPLS services with 3 
sites and one SAP in 5 
min

The complexity of the 
service configuration 
affects response time. 
For example, adding 
additional SAPs to a 
VPLS increases 
provisioning time.

Outstanding 
alarms

The client GUI is able to 
retrieve and display 50000 
alarms in the dynamic 
alarm list during startup.

—

Client GUIs for 
each server

— Open a configuration 
form using the client 
GUI in X amount of 
time.

Measure X against a 
constant platform size 
over time

Device discovery Discover one additional 
devices with an IP address 
in the X.X.X.1 to 255 range 
in less than 1 min.

—
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Billing volume base measures

The 5620 SAM architecture has been designed to allow the quick retrieval of 
statistics. However, using the 5620 SAM-O XML interface and the client GUI 
statistics logging function may cause performance issues that need to be tracked.

Contact your technical support representative for additional statistics planning 
expertise.

In general, keep the following billing volume base measure guidelines in mind:

• When generating statistics using the 5620 SAM-O XML interface, for example 
service octet statistics, there is little difference in performance whether you use 
the a CSV format, XML hierarchical format, or a request for logged statistics. 
There is a less than 100% increase in the amount of time necessary to retrieve the 
statistics for 500 interfaces compared to the time necessary to retrieve the 
statistics for 5000 interfaces when using CVS or logged statistics formats. There 
is a less than 200% increase for the XML hierarchical format.

• When generating statistics using the 5620 SAM-O XML interface, for example 
service octet statistics, sending the statistics to an XML flat file greatly increases 
the amount of time necessary to write the statistics to the file. There is a five-fold 
increase in the amount of time necessary to retrieve statistics for 500 interfaces 
compared to the time necessary to retrieve the statistics for 5000 interfaces using 
the XML flat file retrieval method.

• When generating interface statistics using the 5620 SAM-O XML interface, for 
example additional interface statistics, there is a large difference in performance 
between formats. The CSV format and logged statistics formats perform more 
quickly, with little difference in retrieval time as the number of interfaces are 
increased. The XML hierarchical and flat file formats perform much more slowly 
as the number of interfaces are increased.

• When generating logged statistics using the client GUI, users are limited to 
retrieving a number of records that will not tax the processing capabilities of the 
5620 SAM server. Any request that would generate an excessive number of 
logged statistic records is blocked, and the user is prompted to narrow the search 
for logged records using the appropriate filtering criteria.

Reachability base measures

System reachability is important in business-critical applications. Service 
reachability components are:

• Can the customer reach the service? (reachability)
• If so, is the service available for customer use? (service availability)
• If not, how frequently and how long do service outages last? (service outage 

duration)

The types of measures and baselines necessary to ensure reachability and availability 
are network-dependent, and would vary depending on the topology of the network, 
the networking technologies used to move data, and the types of equipment used.
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Reachability

A test point is reachable from a testing measurement agent when the agent can send 
packets to the test point and receive a response from the test point that the packet was 
received. The ping test and the OAM diagnostics using the 5620 SAM or CLI to a 
device can test reachability. The results from these tests should be recorded for future 
baselining.

These tests can be performed when you troubleshoot a customer service, or when you 
perform SLA tests before you enable a customer service.

Service availability

The network between a measurement agent and a test point is considered available 
at a given time when the measured packet loss rate and the round trip delays are both 
below predefined thresholds. The threshold values are dependent on network 
topology. The ping test and the OAM diagnostics using the 5620 SAM or CLI to a 
device can test service availability. The results from these tests should be recorded 
for future baselining.

Service outage duration

The duration of an outage is defined as the difference between the time a service 
becomes unavailable and the time it is restored. Time between outages is defined as 
the difference between the start times of two consecutive outages. Troubleshooters 
that resolve customer problems, or the data generated to resolve SLAs, can provide 
the baseline metrics to measure outages, and the time between outages. Record the 
information for future baselining.
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3.1 Managing alarms

In large 5620 SAM-managed networks where 5620 SAM applications are constantly 
interacting with a busy network in a non-stop management environment, many 
alarms are raised on the 5620 SAM. These alarms should be:

• tracked as they arrive
• historically logged for trend and performance analysis

You should review alarms on a daily basis to check the type and characteristics of 
the alarms, and to resolve the network problems caused by the alarms. You can 
analyze the alarm history log to determine whether there are any chronic or 
prolonged failures, or trends. You should correct physical equipment failure alarms 
or network device alarms immediately.

Procedure 3-1  To list all incoming alarms

1 Click on the Alarm Table tab button at the bottom of the 5620 SAM client GUI.

The dynamic alarm list appears. The dynamic alarm list allows you to monitor all 
incoming network and network management domain alarms, as shown in 
Figure 3-1.

Figure 3-1  Dynamic alarm list

2 Right-click on an alarm entry row.

The contextual alarm menu appears.

3 Handle the alarms according to your company alarm policies.

For example, to acknowledge an alarm and then delete the alarm:

i Choose Acknowledge Alarm(s) from the contextual menu.

Note —  If your NOC is organized to feed alarm streams from 
multiple vendor equipment to a third-party application, you should 
verify that all alarms are correctly logged by the third-party 
application and then remove alarms from the 5620 SAM client GUI 
alarms. You can use the Faults tab on most 5620 SAM client GUI 
forms to view correlated alarm information for specific objects. See 
the 5620 SAM User Guide for more information.
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The Alarm Acknowledgement form appears.

ii Modify the Severity and Urgency parameters, as required.

iii In the Acknowledgement Text parameter, enter data about the alarm, 
according to your company alarm policies.

iv Click on the OK button.

v Confirm the action.

The Ack column in the alarm row indicates that the alarm is acknowledged.

vi Choose Delete Alarm(s) to delete the alarm.

Procedure 3-2  To store alarms to an alarm history log and view 
alarm history logs

1 Choose Administration→Alarm Settings from the 5620 SAM main menu.

The Alarm Policy form appears.

2 Click on the Global tab button.

3 Click on the Alarm History DB Behavior tab button.

4 Set the alarm history behavior:

i Specify the Max Log Size (records) parameter to set the maximum size of the 
alarm history log. You can store more than 1,000,000 historic alarms in the 
alarm history log.

ii Specify what happens when the alarm history log exceeds the maximum log 
size by setting the Log Full Action and Clear Window (records) parameters. 
This removes the specified number of log records that are removed when the 
round-robin log full action takes effect. This removes the specified number of 
log records to accommodate new log records. By default, the Clear Window 
(records) parameter is set to delete 500 alarm history log records when the log 
is full using the Log Full Action parameter Round Robin option.

iii Set the Administrative State parameter to Up to enable alarm history logging.

iv Select the Log on Change check box to specify whether to log an alarm when 
one of its properties changes, for example, to log an alarm when the alarm is 
acknowledged.

v Select the Log on Deletion check box to specify whether to log an alarm when 
it is deleted.

Caution —  You cannot recover a deleted alarm unless you store alarms 
in the alarm history log. Perform Procedure 3-2 to store the alarm in the 
history log.
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5 Set filters to the DB policy to determine the criteria for an alarm to be logged:

i Click on the Set Purge Range button.

The Alarm History Filter form appears.

ii Choose the filter type by selecting one or more filters from the Unused 
Properties list. The Unused Properties list shows all the alarm record fields.

For a complete history log, filter alarms based on a criterion that all alarms 
share. For example, when your company policy is to ensure that all alarms 
have a severity of Cleared before they are retired, choose Severity from the 
Unused Properties list.

iii Click on the right-facing arrow to move the selected filters to the Filtered 
Properties list.

iv Configure the properties of the alarm information field to specify filtering 
criteria.

For example, set Severity to Cleared. This ensures that all alarms set to 
Cleared are sent to the alarm history log.

v Click on the OK button.

6 Delete the alarms according to your alarm handling policies.

The deleted alarms are logged to the alarm history logs.

7 To view logged alarm history records:

i choose Tools→Historical Alarms from the 5620 SAM main menu.

The Alarm History Filter form appears.

ii If required, choose a filter to narrow the range of historical alarms displayed.

iii Click on the OK button.

The historical alarms appear based on the filtering criteria.

8 Review the alarm history log data for trends and other fault management purposes. 
Transfer the data from the 5620 SAM platform for post-processing, as required.

Note —  Alcatel recommends that you select the Log on Deletion option, 
to ensure that there are logged records of all deleted alarms, saved as 
historical alarm records.

Note —  When you sort more than 50,000 outstanding or logged alarms, 
GUI performance is affected. Use filters to limit the number of alarms that 
are listed.
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3.2 Verifying device synchronization

You should monitor device synchronization to ensure that the 5620 SAM database 
matches the device database. There are multiple ways to ensure managed devices and 
the network management domain stay in sync.

• You can get out of sync if SNMP traps are lost or the 5620 SAM server is running 
above peak capacity. Use LAN monitoring tools to check for collisions and errors 
in the network management domain.

• If the poller policy interval is not scheduled often enough, or if changes are made 
to managed devices between polling intervals, you can use the Resync button to 
update device database information to the 5620 SAM.

Procedure 3-3  To verify device synchronization

1 Use your company IT policies to check the LAN for collisions and errors.

2 Check for deployment failures, which may indicate that communication to a 
managed device is failing or has failed:

i Choose Administration→Deployment and Site Backup/Upgrade from the 
5620 SAM main menu.

The Deployment and Site Backup/Upgrade form appears.

ii Click on the Deployers tab button.

The list of deployers appears.

iii Click on the Refresh button to generate an up-to-date deployers list.
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When no deployers are displayed, deployment problems are not causing a 
synchronization issue.

iv View the state of the deployer in the State column. The possible states of a 
deployer include:

• Deployed
• Pending
• Failed — Resource Unavailable. Failure occurred because one of the 

resources required to apply the configuration is not in the 5620 SAM 
database.

•  Failed — Configuration. Failure occurred because the configuration could 
not be applied to the specified objects.

• Failed — Partial. Failure occurred at deployment and some of the 
configuration can been sent to the network.

• Failed — Internal Error. Failure occurred due to general error conditions. 
The state is intended for all other possible errors.

• Cancelled
• Postponed

v Find the source of the deployment problem. For example, for a failed 
configuration state, ensure the configuration was performed correctly on the 
client GUI.

3 The 5620 SAM uses poller policies to determine how often to check the device MIBs 
for database updates. Check the MIB polling policies by choosing 
Administration→Poller Policies from the 5620 SAM main menu.

The poller manager form appears.

4 Click on the General tab button.

5 Verify the Base Polling Interval parameter. The parameter specifies how often all 
device MIB elements are polled for changes to their MIBs. An interval greater than 
4 hours may cause discrepancies between the device database and the 5620 SAM 
database.

You can:

a Change the Base Polling Interval parameter value to poll MIBs more often.

b Change the polling ratio for specific MIBs and MIB tables to poll them less 
often.

i Click on the MIB Entry Policies tab button.

A list of MIBs appears.

ii Choose one or more MIBs from the list for the type of device that you are 
synchronizing. For example, to resynchronize 7450 ESS interfaces, 
choose the Alcatel-ESS-7450 IF-MIB.

Note —  Polling and scanning use system resources, which can 
increase the amount of management traffic. Consider your network 
needs and network management domain capabilities when you set MIB 
polling policy parameters.
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iii Click on the Edit button to specify a different polling ratio for one or more 
MIBs.

The poller policy form for the selected MIB appears.

iv Specify the Polling Ratio parameter. For example, when the Base Polling 
Interval parameter is set to poll every 4 h, you can set the Polling Ratio 
parameter for a specific MIB to 2. This means that the MIB is polled once 
in two times the base polling interval, or every 8 h.

v Click on the Apply button to save the changes.

c Use the Resync button for the device to update the 5620 SAM database.

i Click on a network device icon in the navigation tree.

ii Right-click and choose Resync from the contextual menu.

A dialog box appears.

iii Click on the Yes button to confirm the request.

The 5620 SAM reads the device database and updates the 5620 SAM 
database.

3.3 Scheduling a database backup

Alcatel recommends that you back up the database to prevent the loss of network 
data if a disk failure occurs. You should perform backups every day and after you 
make major changes to the network. 

Schedule database backups during low activity times to minimize the impact on 
processing requests from XML OSS clients and client GUIs.

Procedure 3-4  To schedule a daily database backup

1 Choose Administration→Database from the 5620 SAM menu.

The Database Manager form appears.

2 Click on the General tab button.

3 Ensure that the Archive Log Mode parameter is set to ARCHIVELOGMODE. This 
allows database backups, and is configured during installation. Contact your 
technical support representative for more information about reconfiguring the 
database to use ARCHIVELOGMODE.

4 Ensure that the Open Mode parameter is set to READ WRITE. This allows the user 
to modify the database.

5 Click on the Backup tab button.

6 Click on the Schedule backup button.
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The Database Backup configuration form appears.

7 Configure the backup schedule.

i Set the Backup Frequency parameter to specify the backup interval. For 
example, when you set the Backup Frequency parameter to 24 and the 
Frequency Unit parameter to hour, a backup is performed every 24 h.

ii Set the Frequency Unit parameter to specify the unit of time. The options are: 
never, minute, hour, or week.

iii Click on the Next button.

iv Enter the root backup directory. This is the directory on the database server 
where the backup databases are stored. The backups are stored in three 
directories: backupset1, backupset2, and backupset3.

The following requirements apply to the root backup directories.

• The directories must reside on the database PC or workstation.
• The Oracle user must have at least 700 permissions on a workstation.

v Click on the Finish button.

8 Regularly review the scheduled backup data. The backup status data includes:

• whether a backup schedule has been configured
• whether the last backup succeeded or failed
• when the last successful and last attempted backup was completed
• the next scheduled backup time

9 Click on the Cancel button to close the form.

3.4 Collecting and storing system and log files

When a 5620 SAM system has run for long periods with significant activity, the 
number of log files generated can use large amounts of disk space. Ensure that the 
contents of the various log directories are backed up on a regular basis to maintain a 
system activity record, and to ensure that a copy of the system configuration files is 
available for research and restores.

Note —  Database backup timers start after you save the configuration. 
For example, when you schedule database backups every 24 hours, and 
you save the configuration at 2:30 p.m., the automatic database backup 
is performed the next day at 2:30 p.m.

Note —  After you restore a database, you must perform a full resync of 
the network to discover any changes to the managed devices, or any new 
managed devices. See Procedure 3-3 for more information.
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Procedure 3-5  To collect and store system and log files

1 Collect the installation log files from the tmp directory with the title 
5620nameofapplication.txt and from the install_directory with the title 
5620nameofapplication.txt, where nameofapplication is the client, server, or 
database.

2 Collect the following 5620 SAM database, server, and client system and log files, as 
required.

i Collect the database dbconfig.properties file, which contains database 
configuration setting information, from the install directory/config directory or 
folder.

ii Collect the server nms-server.xml file, which contains server configuration 
setting information, from the install directory/nms/config directory or folder.

Collect the EmsServerLog file, which contains logged actions performed by the 
server, from the install directory/nms/log directory or folder. There may be 
many log files in the directory or folder, depending on how long the 5620 SAM 
software has been running.

iii Collect the client nms-client.xml files on each client GUI, which contains 
individual client configuration setting information, from the install 
directory/nms/config directory or folder. Rename the files to indicate which 
client GUI they were copied from.

Collect the EmsClientLog, which contains logged actions performed by the 
client GUI, from the install directory/nms/log directory or folder. There may be 
many log files in the directory or folder, depending on how long the 5620 SAM 
software has been running.

3 FTP or copy the system files and log files to a secure PC or workstation that is not 
on the network management domain LAN for review or storage.

3.5 Backing up NMS domain platforms

Alcatel recommends that you should backup all NMS domain platforms running 
5620 SAM application software on a daily basis.

Use your company IT or LAN maintenance policies to create backups of all 
directories or folders on the platforms. The backups can be used to restore an entire 
platform if there is a catastrophic error due to a platform hardware or operating 
system failure.
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4.1 Verifying performance statistics collection

Use the performance monitoring statistic log records to determine whether 
performance statistics are collected within the scheduled interval using the client 
GUI.

Procedure 4-1  To check for performance monitoring statistics 
collection

1 Choose Tools→Log Records from the 5620 SAM main menu.

The Manage Log Records window appears.

2 Configure the Log Class parameter to specify the type of performance monitoring 
statistics that you want to collect. For example, to check interface statistics for 
managed devices, choose Interface Additional Stats (equipment).

3 Set the Log Type parameter to Log Record to retrieve a list of historical data for the 
type of logged statistics.

4 Configure the filter.

i Choose a filter from the Unused Properties list and click on the right-facing 
arrow. For example, to limit the log retrieval to one specific device, choose Site 
Id from the list.

The filter appears in the Filtered Properties list.

ii Set the parameters to EQUALS and the filter value, for example, set the Site 
Id EQUALS and enter the IP address of the managed device.

iii Click on the OK button.

The Filter (Browse Log Record) form closes.

5 Review the Browse Log Record data for the selected statistic.

i Click on the Monitored Object or Monitored Object Name headings to sort the 
historical statistics records by type of object.

ii Review the Time Captured heading for one or more objects.

Verify that the time captured intervals match the intervals set for the object or 
the statistic logging class, as specified in the 5620 SAM User Guide.

If the time captured intervals are not sufficient, there will be gaps in the 
historical record.

Note —  You must specify a filter to limit the number of log records to 
less than 15 000, otherwise a problem encountered form appears.
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6 If there are gaps in the historical record, check the polling policy parameters to 
ensure:

• the base polling interval is sufficiently long to collect the required statistics
• the polling ratio for a specific MIB or MIB entry is sufficiently long to collect the 

required statistics

7 Record the data for the selected device and type of statistics. Use this data as a 
base measurement to verify that statistics data was collected correctly over the 
scheduled interval.

4.2 Gathering inventory data for device base performance 
checks

You can collect device hardware inventory information to:

• create a list of managed devices objects, for example, access ports that are 
available as SAPs

• save the lists for future processing and inventory uses
• compare the current and historical lists for status change trends, usage, and other 

post-processing applications
• record the time required to gather inventory data as a base measure for future 

performance checks

Procedure 4-2  To gather port inventory data

For most lists you can:

• generate an inventory of the listed data
• reorganize the information from most important to least important
• remove columns of data
• sort in ascending or descending order

1 Choose Application→Equipment Manager from the 5620 SAM main menu.

2 Filter on the Site Name for the device from which you want to collect port 
information.

3 Set the Network Element parameter to the Site Name specified in step 2.

The equipment manager displays the device.

4 Click on the Ports tab button.

A list of ports appears with the Physical Ports tab button selected.

Note —  Each row that represents a log record shows the Suspect 
column. When a check mark is present for an interval, there may have 
been a problem with collection during that interval.
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5 Generate a list based on the inventory collection or comparison you plan to make. 
For example, to compare weekly lists of access ports, generate a filter to list only 
access ports:

i Right-click on the Site ID heading and choose Edit Filter from the contextual 
menu.

The Physical Port Filter form appears.

ii Choose the Mode filter from the Unused Properties list and click on the 
right-facing arrow.

The Mode property moves to the Filtered Properties list.

iii Choose EQUALS and Access for the Mode filter.

iv Click on the OK button.

Only access ports appear in the list.

6 Record the amount of time required to generate the inventory list for future base 
measure comparisons.

7 Show or hide columns of access port information as required. For example, to hide 
Administrative State information:

i Right-click on the Site ID heading.

The contextual list menu appears.

ii Deselect the Administrative State check box.

The Administrative State data is removed from the access port list.

8 Save the list of access ports.

i Choose Save To File from the contextual list menu.

The Save form appears.

ii Enter a filename, for example, access_device123_dateoflistgeneration.

iii Choose the file type: HTML or text.

iv Choose a location on the 5620 SAM client GUI to save the file.

v Click on the Save button.

The file is saved to the selected location. Figure 4-1 shows a list table saved in 
HTML format.
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Figure 4-1  Port list in HTML format

9 You can save the table preferences for future use.

i Choose Save Table Preferences from the contextual menu.

A dialog box appears.

ii Confirm the action by clicking on the Yes button.

The table preferences for the list form and user are saved. For example, when 
you choose another device, and click on the Ports tab button and the Physical 
Ports tab button, the Administrative State heading is not displayed. However, 
when you click on the SONET Channels tab button, the Administrative State 
heading appears.

10 Move the file to another PC or workstation, as required, for inventory analysis or 
post-processing.

4.3 Testing 5620 SAM database restores

When you create daily 5620 SAM database backups, the 5620 SAM backups should 
be tested to ensure that they can be used to restore the 5620 SAM database, in the 
case of a catastrophic failure.
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Procedure 4-3  To test a 5620 SAM database restore

1 Generate comparison points for the 5620 SAM database, for example, the number 
of managed devices and cards. Create an inventory of information, as described in 
the 5620 SAM User Guide. This information will be used to compare the validity of 
the backup database version.

2 Ensure a 5620 SAM database backup has been performed, as described in 
Procedure 3-4.

3 Shut down:

• any currently running 5620 SAM applications on the PC or workstation where 
the database restore test is to occur

• other 5620 SAM applications in the domain where the restore is to occur

4 FTP a backup version of the database to the test PC or workstation.

5 Ensure that the test PC or workstation database environment is configured the 
same as the actual database PC or workstation, as described in the 5620 SAM 
Installation and Upgrade Guide.

6 As oracle user, launch the 5620 SAM database configuration tool from the 
appropriate directory on the product DVD.

a For Windows, double-click on the DBconfig.exe file.

b For Solaris, type:

./DBConfig.bin ↵

The 5620 SAM database configuration tool is launched.

7 Accept the license agreement.

8 Follow the prompts, as specified in the 5620 SAM Installation and Upgrade Guide. 
Specify a restore of the database from a backup version.

Caution 1 —  Do not perform the database restore test in the NMS 
domain. Ensure that there is no IP connectivity to any live network 
devices.

Caution 2 —  This procedure does not cover managed device 
database backups. See the 5620 SAM User Guide for more 
information about managed device database backups and restores.

Caution —  Performing any database modifications using the Oracle 
database or tablespace tools can cause irreparable harm to the database 
and your network management data. Performing such modifications can 
void your Alcatel warranty and support agreements. Contact your Alcatel 
technical support representative to help you troubleshoot your database.

Caution —  The PC or workstation should not have IP connectivity to the 
managed devices in the network.
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9 Enter the following database restore information, which is available from the 
dbconfig.properties file or the Administration→Database 5620 SAM client GUI main 
menu:

• database name
• DBID, which is the unique numerical identifier of the database
• database instance name

10 Specify the backup directory where the backup version of the database can be 
found.

11 Specify whether to create a copy of the backup database.

When the backup database is restored, Oracle modifies the backup and it cannot 
be reused. Create a copy if you want an additional backup database copy.

12 Specify any additional parameters, as listed in the 5620 SAM Installation and 
Upgrade Guide.

13 For Solaris installations, run the following from the install 
directory/config/databasename directory:

solaris_root.sh ↵

This script enables automatic database startup and shutdown at reboot.

14 Review the comparison points of the restored backup database with the actual 
database, as generated in step 1.

When the databases are the same, the backup and restore works correctly.

4.4 Checking scheduled device backups

When you use the 5620 SAM to back up managed device configurations, the 
5620 SAM FTPs to the device for the following files:

• node bof (bof.cfg)
• primary-config specified in the bof
• index (primary-config with a .ndx extension)

See the 5620 SAM User Guide for more information about scheduling device 
configuration backups.

Use the following procedure to verify that device configuration backups are 
performed correctly, and that the backups are available if required.

Procedure 4-4  To check scheduled device backups

1 Choose Administration→Deployment and Site Backup/Upgrade from the 5620 SAM 
main menu.

The Deployment and Site Backup/Upgrade form appears.
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2 Click on the Backup/Restore Policy tab button.

3 Check the following:

• the Scheduled Backup Frequency parameter to determine how often device 
configuration backups are scheduled

• the 5620 SAM Server Repository Root Path parameter for the directory where 
the device configuration backups are stored

4 Click on the Backup/Restore Status tab button.

A list of the backups and restores appears. The Restore State column of the backup 
should indicate the backup success for each of the managed devices.

5 Double-click on a row to view the backup and restore configuration information.

Click on the appropriate tab for more information about:

• backup status
• software images stored in backup folders
• alarms raised because of backup problems

The number of stored backup configuration files should match the scheduled 
backup frequency, and should be stored in the location specified in the repository 
parameters, as indicated in step 3.

6 Double-click on a row for a specific backup.

The backup restore form appears.

Click on the appropriate tab for more information:

• Configuration File for information about the primary config file
• Boot Option File (BOF) for information about the node bof file
• Index File for information about the primary config file with the .ndx extension

Each of the tab buttons displays information about the version of the file, the file 
header, the FTP location of the file, and whether the configuration backup file can 
be used to restore the device database.
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5.1 Generating and storing a user account list 5-2

5.2 Verifying documentation and support contact list 
updates 5-3

5.3 Setting the time and date 5-4

5.4 Checking Windows PC platform performance 5-5

5.5 Checking Solaris workstation platform performance 5-7

5.6 Checking LAN TCP/IP connections between network 
management domain elements 5-10
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5.1 Generating and storing a user account list

System administrators should keep a record of 5620 SAM users to:

• associate staff names with user accounts
• provide account information to TAC or Support staff as required for support to 

log in
• review user account privileges

Procedure 5-1  To generate and store user account data

1 As admin, choose Administration→Security→5620 SAM User Security from the 
5620 SAM main menu.

The Security Management (Edit) form appears.

2 Click on the Users tab button.

3 Click on the Search button without setting any filtering.

The complete list of user accounts appears.

4 Organize the list of users. For example, to organize the list by the type of group that 
the user belongs to, click on the Security Group header. The user accounts are 
listed alphabetically by group.

5 Save the list of user accounts.

i Right-click on a list heading and choose Save To File from the contextual 
menu.

The Save form appears.

ii Enter a name for the user account list, for example, 
NOCabc_useraccounts_yearmonthday.

iii Choose the file type: HTML or text.

iv Choose a location on the 5620 SAM client GUI to save the file.

v Click on the Save button.

The file is saved to the selected location.

6 Move the account list to a secure location. Store the latest version of the list and 
keep existing versions of the list for historical purposes.
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5.2 Verifying documentation and support contact list updates

Use the www.alcatel.com website as the source for 5620 SAM technical information 
and updates to:

• check for changes to TAC, Support, and Call Centre information
• find additional product updates, updated user documentation, and documentation 

generated for specific situations, such as Network Application Notes, Product 
Change Notifications, and Field Notices

You should also regularly check your 5620 SAM platform vendors’ websites for 
information about operating system patches, updates, and other software and 
hardware issues.

Procedure 5-2  To check for documentation and support updates

1 Log on to www.alcatel.com.

2 Click on the Support→Support Documentation Service link.

3 Enter your login user name and password when prompted.

4 Narrow the documentation search to 5620 SAM.

i Set the Select a product category field to Network Management.

The Select a product field list is updated.

ii Set the Select a product field to 5620 SAM.

iii Set the Select a type field to the type of information you are looking for, for 
example:

• All types to view all applicable documentation for the product
• Installation for a list of installation guides, sorted by date and release
• Product Manual for list of guides, such as the 5620 SAM User Guide, 

sorted by date and release
• Release Description for a list of release descriptions that describe release 

information, such as feature overviews, supported platforms, and 
scalability considerations

• Release Notice for a list of release notices that describe load information, 
such as outstanding and closed problem lists, and restrictions to 
functionality

5 Click on the Search button.

The list of documents appears.

Note —  You must have a Support Documentation Service account to 
view customer documentation. Contact your Alcatel account 
representative for more information.
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6 Download the documents.

7 Check for TAC, Call Center, or Support updates:

i Click on the Support link.

ii Click on the Global Support link.

iii Click on the Carrier/Service Provider link.

iv Click on the global technical support organization that supports your 
organization.

v Check the contact information for your regional Customer Service or Call 
Center.

5.3 Setting the time and date

You can use a variety of time synchronization and network time protocol tools, 
depending on network design needs, including:

• ntp, xntpd, or rdate for network management domain devices
• clock functionality on Windows PCs
• sntp for network devices

Alcatel recommends that you keep time synchronous between network devices, for 
example, timing between routers. See the appropriate operating system 
documentation or man pages for more information about using time and date 
synchronization protocols.

Procedure 5-3  To set time and date

1 Use ntp or xntpd to configure the NMS domain device to communicate with an 
appropriate time synchronization server, such as an ntp server. See the appropriate 
man pages or operating system documentation for more information.

2 When ntp or xntpd are not used, you can use rdate on a Solaris platform.

Note —  You can also use the enhanced search feature to search for 
5620 SAM updates between specified dates. Alternately, you can 
configure your user profile on the Alcatel home page to automatically 
notify you of new 5620 SAM user information.
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i As root, change to the crontabs directory by typing:

cd /var/spool/cron/crontabs ↵

ii Set the environment to edit the root crontab file using the vi text editor by 
typing:

csh ↵

setenv EDITOR=vi ↵

export EDITOR ↵

crontab -e ↵

iii Add the following line at the end of the crontab file, for example, to synchronize 
time in the NMS domain at 1:57 a.m. every day:

 57 1 * * * /bin/rdate ↵

This cron job executes the rdate command every day at 1:57 a.m. 

iv Save the changes and close the file.

v Repeat step 2 as required for all NMS domain devices, for example, client 
GUIs workstations.

Network devices such as the 7750 SR are configured to operate on 
coordinated universal time. You can configure additional time synchronization 
methods, such as sntp, as described in the appropriate documentation, for 
example, the 7750 SR OS System Guide.

5.4 Checking Windows PC platform performance

You can compare PC performance monthly to:

• ensure that there is no degradation in performance
• collect base measure information related to platform performance

Procedure 5-4  To check Windows PC performance

1 Open a command prompt on the PC.

2 Type:

ping name_of_machine ↵

where name_of_machine is the managed device or network management domain device to which 
you want to test connectivity

Caution —  Alcatel recommends that you do not perform this procedure 
when your NMS PCs and workstations are in different time zones. 
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3 Review the ping output for round trip delays or lost packets. Resolve any LAN 
connectivity issues that cause delays or dropped packets according to your IT 
policies. Store ping round trip delay or lost packet data as a performance base 
measure for the PC. You can use the data for future comparisons of performance.

4 Choose Start→Run from the Windows menu bar.

The Run form opens.

5 Type taskmgr.

The Windows Task Manager provides details about the programs and processes 
that run on the PC. If you are connected to a LAN, you can also view the network 
status and check network performance. Depending on the NOC work environment 
and shared computer usage policy, you can also view additional information about 
other users.

6 Click on the OK button.

The Windows Task Manager form appears.

7 Check performance using the appropriate Task Manager tab button.

a Click the Processes tab button.

A list of processes appears.

Organize the processes according to CPU usage. Any processes with the User 
Name tims is a 5620 SAM process.

b Click on the Performance tab button.

The CPU and page file usage charts appear.

The CPU, memory, and page file usage percentages should fall within your IT 
specifications or the established performance base measures.

c Click on the Networking tab button.

The local area connection chart appears. 

Network utilization greater than 10 to 20 percent may indicate that collisions 
are occurring on the LAN that may affect performance in the network 
management domain.

8 Choose File→Exit Task Manager to close the form.

9 Open a command prompt on the PC.

10 Type:

tracert name_of_machine ↵

where name_of_machine is the managed device or network management domain device to which 
you want to test connectivity

The tracert command provides details about connectivity from one connected 
device to another connected device, for example, from a 5620 SAM database to a 
5620 SAM server.
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11 Review the tracert data, including:

• number of hops to reach the far-end device
• average time between hops

Record the data for future base measure comparison. For example, when the 
number of hops between a client GUI and server increases over time, network 
management traffic may take longer to travel between them, which may degrade 
performance.

12 Check regularly for advisories related to the operating system. If updates or patches 
are required, contact your IT department or your Alcatel support representative for 
information about potential impacts to 5620 SAM software.

5.5 Checking Solaris workstation platform performance

Use the following procedure to test performance and record base measures.

Procedure 5-5  To check Solaris workstation performance

Use UNIX utilities to review process and CPU usage data.

1 Open a command or shell tool.

2 Change to the 5620 SAM install directory by typing:

cd /install directory ↵

where install directory is the installation directory of the 5620 SAM software

3 Run the prstat command on the client GUI, server, and database workstations to 
check CPU usage for processes:

i Type:

prstat ↵

Depending on your system configuration, approximately the top 20 processes 
are displayed.

ii Review the output.

 The top 5620 SAM process listed under the CPU column should be the Java 
process. However, the Java process should not consume the majority of CPU 
cycles, compared to previous base measures. Some Oracle processes may 
also take CPU time, depending on the database load.

iii Record the data for future base measure comparison of workstation 
performance.

iv Press ESC-Q to quit or CTRL-C to stop the prstat command.
Alcatel 5620 Service Aware Manager, Release 3.0 R1 5-7
October 2005 95-5960-01-00-A



5 —  Monthly maintenance tasks
4 Use the UNIX utility mpstat command to review the activities performed by the CPU.

i To provide 5 s of output, type:

mpstat -X 5 ↵

ii Review the mpstat output. Ignore the first line of data, because the sample 
period is not the full 5 s.

The following shows sample mpstat output. See Table 5-1 for a description of 
the output.

CPU minf mjf xcal  intr ithr  csw icsw migr smtx  srw syscl 

 0   5 0  0 258   55   87    1 0    0    0   196

usr sys  wt idl

5 15 0  80

Table 5-1 mpstat output description

The key information generated from the mpstat command is the smtx data. 
When the smtx output is high on a multiple CPU system, the CPUs are 
competing for resources. 

iii Record the data for future base measure comparisons of workstation 
performance.

Heading Description (events per second unless noted)

CPU Processor identification

minf Minor faults

mjf Major faults

xcal Interprocessor cross-calls

intr Interrupts

ithr Interrupts as threads (not counting clock interrupts)

csw Context switches

icsw Involuntary context switches

migr Thread migrations to another processor

smtx Spins on mutexes (lock not acquired on first try)

srw Spins on readers/writer locks (lock not acquired on first try)

syscl System calls

usr Percent user time

sys Percent system time

wt Percent wait time

idl Percent idle time
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Look for differences in the output of the data for similar loads on each 
workstation. This would indicate performance degradation.

iv Press ESC-Q to quit or CTRL-C to stop the mpstat command.

5 Use the iostat command to collect disk bottleneck data and determine whether there 
is a disk bottleneck.

i Type:

iostat -x time ↵

where time is the time period, in seconds, over which you want to collect data. Alcatel 
recommends that you start with 2 s.

ii Review the iostat output. The following shows iostat output. See Table 5-2 for 
a description of the iostat output.

                          extended disk statistics

disk     r/s  w/s   Kr/s   Kw/s  wait actv  svc_t  %w  %b

sd1      0.1  0.2    0.9    3.3   0.0  0.0   34.3   0   0

sd3      0.1  0.5    1.1    3.7   0.0  0.0   73.1   0   90

Table 5-2 iostat output description

iii The %b and svc_t columns are the key fields to determine whether a disk 
bottleneck exists. When the svc_t is between 30 and 50 ms, and the %b) is 
greater than 20% busy, there is a minor disk loading problem. If the svc_t 
exceeds 50 ms, the disk is considered disk or I/O bound, and a disk bottleneck 
exists.

Heading Description

disk Name of the disk

r/s Reads per second

w/s Writes per second

Kr/s Reads per second (kb/s)

Kw/s Writes per second (kb/s)

wait Average number of transactions waiting for service (queue length)

actv Average number of transactions actively being serviced (removed from the queue 
but are not yet complete)

svc_t Average service time in ms

%w Percentage of time there are transactions waiting for service (non-empty queue)

%b Percentage of time the disk is busy (transactions in progress)
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In the sample output, the sd3 disk had 90% disk activity in the %b column. 
Because disk sd3 is busier than disk sd1, disk performance may be enhanced 
by moving data from disk sd3 to disk sd1.

iv Record the data for future comparison of workstation performance. Look for 
differences in the output of the data for similar loads on each workstation. This 
would indicate performance degradation.

v Press CTRL-C to stop the iostat command.

6 Use the netstat command to check for network interface performance issues.

i Type:

netstat -i time ↵

where time is the time period, in seconds, over which you want to collect data. Alcatel 
recommends that you start with 5 s.

ii Review the netstat output.

5.6 Checking LAN TCP/IP connections between network 
management domain elements

Use the ping and trace route functions each month to check LAN TCP/IP 
connectivity between the network management domain elements, such as 5620 SAM 
clients, server, and database platforms. Contact your IT department if there are 
communication problems.

Procedure 5-6  To check network management connections

1 Open a command console or DOS shell on the workstation or PC.

2 Try to ping the host name of another PC or workstation by typing:

a For workstations:

ping -s name_of_machine ↵

where name_of_machine is the name of the network management domain workstation

b For PCs:

ping name_of_machine ↵

where name_of_machine is the name of the network management domain PC

3 Review the output. The following shows sample output.

# ping -s name_of_machine

PING name_of_machine: 56 data bytes

64 bytes from name_of_machine (138.120.106.169): icmp_seq=0, 
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time=1. ms

64 bytes from name_of_machine (138.120.106.169): icmp_seq=1, 
time=0. ms

64 bytes from name_of_machine (138.120.106.169): icmp_seq=2, 
time=0. ms

^C

----name_of_machine PING Statistics----

3 packets transmitted, 3 packets received, 0% packet loss

round-trip (ms) min/avg/max = 0/0/1

LAN congestion may be a problem if the packets were received out of order, some 
packets were dropped, or some packets took too long to complete the round trip.

4 Store the output for future base measure comparison.

Compare the output over time to ensure that changes in the data are not caused by 
deteriorating LAN conditions.

5 To check routing information:

i Open a DOS command or shell tool on the PC or workstation.

ii Run a trace route command to determine the path taken to a destination by 
sending an ICMP echo request message.

• Type traceroute on a Solaris workstation
• Type tracert on a Windows PC

The list of near-side interfaces in the path between a source host and a 
destination machine is displayed. The near-side interfaces are the interfaces 
closest to the source host.

6 Store the output as a record for future base measure comparisons. Compare routes 
over time to ensure that there is optimal connectivity.

7 To check the routing tables for the platform:

i Open a DOS command or shell tool on the PC or workstation.

ii To view the active routes for the platform, type:

netstat -rn ↵

The following information is displayed:

• network destination and gateway IP addresses
• gateway used to reach the network destination
• interface that is the IP address where communication is occurring
• metric value of the route
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8 Store the output as a record for future base measure comparison. Compare routes 
over time to ensure that there is optimal connectivity.
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6.1 Listing subscriber service information 6-2

6.2 Increasing disk space 6-3

6.3 Checking for duplicate service or resource names 6-3
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6.1 Listing subscriber service information

Record subscriber service information to:

• document which devices and interfaces are used to handle customer traffic
• inventory the services used by customers
• provide raw data for post-processing customer service trends and customer 

information

Procedure 6-1  To list service information

1 Choose Manage→Services from the 5620 SAM main menu.

The Manage Services form opens.

2 Choose Service (Service Management) as the filter from the far left panel.

The service parameters appear in the unused properties panel.

3 Choose Service ID from the unused properties panel.

4 Click on the right-facing arrow.

Subscriber ID appears in the filtered properties panel.

5 Type in the subscriber ID.

6 Click on the Search button.

All services for the chosen subscriber ID are listed.

7 Save the list of subscriber services.

i Order the columns of service data as required. For example, you can click on 
the Service Name heading to sort the services by name.

ii Right-click on the Service Name heading and choose Save To File from the 
contextual menu.

The Save form appears.

iii Enter a filename for the subscriber services, for example, 
ABCindustries_services_yearmonthday.

iv Choose the file type: HTML or text.

v Choose a location on the 5620 SAM client GUI to save the file.

vi Click on the Save button.

The file is saved to the selected location.

8 You can record other details about the subscriber services. For example, you can 
list Layer 2 interface information for the subscriber’s VPLS or VLL services.

i Click on the L2 Interfaces tab button.
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The list of Layer 2 interfaces appears.

ii Order the columns of Layer 2 interface data as required. For example, you can 
click on the Service Name heading to sort the Layer 2 interface data based on 
the service name.

iii Right-click on the Service Name heading and choose Save To File from the 
contextual menu.

The Save form appears.

iv Enter a filename for the subscriber service Layer 2 interface list, for example, 
ABCindustries_services_l2interfacesused_yearmonthday.

v Choose the file type: HTML or text.

vi Choose a location on the 5620 SAM client GUI to save the file.

vii Click on the Save button.

The file is saved to the selected location.

9 Save the subscriber service data lists for post-processing on another PC or 
workstation, according to your company policy.

6.2 Increasing disk space

Alcatel recommends that you use a volume control system to control disk space in 
the NMS domain.

If you do not use a volume control system, when performance monitoring of disk and 
platform usage on a Solaris workstation indicate that additional disk space is 
required, you can add more swap space.

See the swap space procedure in the 5620 SAM Troubleshooting Guide for more 
information. See your appropriate PC user documentation or IT department 
guidelines for more information about adding disk space.

6.3 Checking for duplicate service or resource names

Alcatel recommends that you develop standardized naming conventions when 
configuring network objects, which will:

• facilitate the identification of the type of object
• ensure that data passed to a northbound OSS interface or southbound in a data file 

for processing is named consistently across platforms and software products
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Name each object on the appropriate configuration form to identify:

• type of object, for example, a VPLS
• customer associations with the object, for example, a VLL service for XYZ 

Industries
• source and destination of endpoints, for example, the devices that start and 

terminate an LSP
• ports and IP addresses used

You can check for duplicate names to ensure that naming conventions are followed, 
and prevent possible confusion when you deal with customers or with operations 
staff.

Procedure 6-2  To check for duplicate port descriptions

This procedure checks for duplicate port descriptions on all managed devices. You can 
also check, for example, duplicate service names. This procedure assumes that the 
Description parameter uniquely identifies each port.

1 Choose Manage→Equipment from the 5620 SAM main menu.

The Manage Equipment form appears.

2 Generate a complete list of ports:

i Choose Port (equipment) from the list on the left.

The port parameters appear in the Unused Properties list.

ii Choose a port property from the Unused Properties list that generates a 
complete list of ports on managed devices. For example, when all ports are 
administratively up, choose Administrative State (Site) and click on the 
right-facing arrow.

Administrative State (Site) appears in the Filtered Properties list.

iii Set the Administrative State (Site) filter to EQUALS and Up.

iv Click on the OK button.

The Filter Browse Equipment form closes and the Browse Equipment form 
appears with the list of ports.

3 Click on the Description heading to list ports alphabetically by description.

4 Scan the list for duplicate names.

Note —  By default, ports are assigned a description based on the card 
type when the Description parameter is not configured.
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5 If you find a duplicate description, you can modify the description based on your 
naming conventions.

i Click on the port row with the duplicate description.

ii Click on the Edit button.

The port configuration form appears.

iii Change the Description parameter to uniquely describe the port.

iv Click on the OK button.

• The port configuration form is saved.
• The Description name in the Browse Equipment form is updated.

6 Click on the Description table heading to list the ports alphabetically based on the 
updated Description parameter.

7 Click on the Close button.
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Glossary

Numerics

5620 SAM 5620 Service Aware Manager

The 5620 SAM is the network manager portfolio of modules for the 
7750 SR and 7450 ESS.

5620 SAM client The 5620 SAM client provides a GUI to configure IP network elements.

5620 SAM database The 5620 SAM database stores network objects and configurations.

5620 SAM server The 5620 SAM server mediates between the 5620 SAM database, 
5620 SAM client, and the network.

5620 SAM-A 5620 SAM Assurance

The 5620 SAM-A provides service assurance functionality.

5620 SAM-E 5620 SAM Element Manager

The 5620 SAM-E provides network element configuration and management 
functionality.

5620 SAM-O Alcatel 5620 SAM Open Interfaces

The 5620 SAM-O provides an XML interface for OSS applications to 
interact with the 5620 SAM.

5620 SAM-P Alcatel 5620 SAM Provisioning

The 5620 SAM-P provides service provisioning functionality.
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Glossary
A

alarm An alarm is a node-generated message created as a result of an event, such 
as an interface status change.

API application programming interface

An API is a set of programming functions and routines that provides an 
interface to the network for application programs. APIs translate high-level 
program code into low-level computer instructions that run the network. 
Thus, application programs (for example, word processors) can 
communicate with low-level programs handling network data traffic.

C

CLI command line interface

The CLI is an interface that allows the user to interact with the operating 
system by typing alphanumeric commands and optional parameters at a 
command prompt. UNIX and DOS provide CLIs.

CPE customer premises equipment

Network equipment that resides on the customer’s premises.

CPU central processing unit

D

DB database

F

fault A fault is a failure or defect in a network, causing the network, or part of the 
network, to malfunction.

FTP file transfer protocol

FTP is the Internet standard client-server protocol for transferring files from 
one computer to another. FTP generally runs over TCP or UDP.

G

GUI graphical user interface

A GUI is a computer user interface that incorporates graphics to make 
software easier to use.
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H

HTML HyperText Markup Language

Language for writing hypertext documents, often for use in a web 
environment.

I

ICMP Internet Control Message Protocol

ICMP is an extension to the Internet Protocol (IP) defined by RFC 792. 
ICMP supports packets containing error, control, and informational 
messages. The ping command, for example, uses ICMP to test an internet 
connection.

IETF Internet Engineering Task Force

The IETF is the organization that provides coordination of standards and 
specifications developed for IP network and related protocols.

IP Internet protocol

IP is the network layer for the TCP/IP protocol suite. It is a connectionless, 
best-effort packet-switching protocol defined by the IETF.

J

JMS Java Message Service

JMS is an API that combines Java technology with enterprise messaging. 
The JMS API defines a common set of interfaces for creating applications 
for reliable asynchronous communication among components in a 
distributed computing environment, so that the applications are portable 
across different enterprise systems.

JVM Java Virtual Machine

L

LAN local area network

A LAN is a group of computers or associated devices that share a common 
communications line and typically share the resources of a single processor 
or server within a small geographic area, for example, within an office 
building.

Linux Linux is a UNIX-like operating system designed to provide PC a free or very 
low-cost operating system.
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M

MDA media dependent adapter

menu bar The menu bar is a tool on the GUI that organizes tasks across broad 
headings. You can perform functions on the application by selecting an 
action from the menu bar.

MIB management information base

MTU Maximum transmission unit

MTU is the largest unit of data that can be transmitted over a particular 
interface type in one packet. The MTU can change over a network.

N

navigation tree The navigation tree displays a view of all managed equipment, services, and 
protocols, and allows you to navigate through these components.

NE network element

A physical device in the network, such as a 7750 SR router, or a switch, such 
as the 7670 RSP.

network topology A network topology is the layout of a network, which can include the way in 
which elements in a network, such as nodes, are connected and how they 
communicate.

NMS network management system

System responsible for managing at least part of a network. NMSs 
communicate with network elements and other systems to keep track of 
network devices, statistics, and resources.

NOC network operations centre

Part of a telecommunication system architecture used to configure and 
monitor network and service elements.

NPDU network protocol data unit

O

OSS operational support system

A network management system supporting a specific management function, 
such as alarm surveillance and provisioning, in a service provider network.

P

PC personal computer
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Glossary
PDU protocol data unit

A PDU is a message of a given protocol comprising payload and 
protocol-specific control information, typically contained in a header. PDUs 
pass over the protocol interfaces which exist between the layers of protocols, 
as indicated in the OSI model.

ping packet internet groper

An ICMP echo message and its reply. Often used in IP networks to test the 
reachability of a network device.

Q

QoS Quality of Service

QoS is a term for the set of parameters and their values that determine the 
performance of a virtual circuit. This service level is usually described in a 
network by delay, bandwidth, and jitter.

R

RAM random access memory

Storage, the content of which can either written to or read from in a random 
sequence.

router A router is an interface device between two networks, connecting LANs to 
LANs or LANs to WANs. It selects the most cost-effective route for moving 
data between multiprotocol LANs, making sure that only one route exists 
between source and destination devices. Routers make forwarding decisions 
based on network layer addresses.

routing instance A routing instance is the configuration of a router, including information 
such as protocols, interfaces, routing, and policies.

routing protocol  A routing protocol is used to determine the correct route for packets within 
IP and IP/MPLS networks.

S

service-level 
agreement

See SLA.

SLA service-level agreement

An SLA is a service contract between a network service provider and a 
subscriber that guarantees a particular QoS. SLAs are used for providing 
network availability and data-delivery reliability.
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SNMP Simple Network Management Protocol

A protocol used for the transport of network management information 
between a network manager and a network element. SNMP is the most 
commonly used standard for most interworking devices.

SNMP trap An SNMP trap is an unsolicited notification that indicates that the SNMP 
agent on the node has detected a node event, and that the network 
management domain should be aware of the event. SNMP trap information 
typically includes alarm and status information, and standard SNMP 
messages.

SNMP trap log ID SNMP trap log ID is the ID of a log. A valid log ID must exist for alarms and 
traps to be sent to the trap receiver.

Solaris The name for the UNIX operating system variant developed by Sun 
Microsystems.

SSH secure shell

The SSH protocol is used to protect communications between two hosts by 
encrypting a Telnet or FTP connection between the 5620 SAM and some 
nodes. 5620 SAM uses SSH version 1.5. Both ends of the client/server 
connection are authenticated, and passwords are protected by encryption. 

T

TAC technical assistance center

TCP transmission control protocol

TCP is a protocol used, along with the Internet Protocol (IP), to send data in 
the form of message units between computers over the Internet. While IP 
takes care of handling the actual delivery of the data, TCP takes care of 
keeping track of the individual units of data (called packets) that a message 
is divided into for efficient routing through the Internet.

Telnet Telnet is the Internet-standard TCP/IP protocol for remote terminal 
connection service. It allows a user at one site to interact with a remote 
timesharing system at another site as if the user’s terminal connected directly 
to the remote machine.

The Telnet command and program are used to log in from one Internet site 
to another. It gets the user to the login prompt of another host.

tiered architecture Tiered architecture refers to the way in which the GUI and the network 
management components use a Java-based technology that provides 
distributed, secure, and scalable applications. This tiered architecture allows 
for scaling and fair load balancing, which improves performance. 

U

UDP user datagram protocol
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Glossary
UI user interface

See GUI

UNIX UNIX is a multi-user, multitasking operating system, which is used on 
mainframes, workstations, and PCs. UNIX is the basis of Solaris and 
SunOS, which are operating systems used by Sun workstations.

V

VLL virtual leased line

A virtual leased line is a type of VPN where IP is transported in a 
point-to-point manner. CPE devices are connected through nodes, and the 
nodes are connected to an IP tunnel.

VPLS virtual private LAN service

A VPLS is a type of VPN in which a number of sites are connected in a 
single bridged domain over an IP/MPLS network. Although the services 
may be from different locations, in a VPLS, they appear to be on the same 
LAN.

When implemented with Layer 2 interfaces, this service is called VPLS. 
When implemented with Layer 3 interfaces, this service is called an IP-VPN.

W

window Windows are forms, panels of information, equipment drawings, or graphics 
that appear on a screen. Windows commonly allow a user to input data and 
initiate functions but some windows simply display information.

workflow The 5620 SAM workflow is a defined series of tasks that describe how to 
install, configure, create, and manage services.

workstation A UNIX platform where the 5620 SAM software runs.

X

X.733 ITU-T X.733

X.733 is the standard that describes the alarm reporting function.

XML extensible markup language

XML defines the syntax to customize markup languages. The markup 
languages are used to create, manage, and transmit documents across the 
Web. 
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Index

account lists
generating, 5-2

alarms
listing, 3-2
managing, 3-2
storing in history log, 3-3
viewing, 3-3

B

backups
checking for scheduled device, 4-7
scheduling for database, 3-7

base measures, 2-2
billing, 2-7
checklist, 1-3
guidelines, 2-2
inventory, 2-4
performance, 2-6
plaform, 2-2
reachability, 2-7
scalability, 2-5
statistics, 2-7

billing base measures, 2-7

C

checklist, 1-3
connectivity checking, 5-10
contact lists, 5-3

D

database
checking device backups, 4-7
scheduling backups, 3-7
testing restore, 4-5

date and time
setting, 5-4

devices
checking for database backups, 4-7
gathering inventory data, 4-3
verifying synchronization, 3-5

disk space
increasing, 6-3

documentation updates, 5-3
duplicate names

checking for, 6-3

I

inventory
base measures, 2-4
device, 4-3
subscriber services, 6-2

iostat, 5-7

L

LAN connections
checking, 5-10
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log files — Windows platform performance
log files
collecting, 3-8

M

maintenance, 1-2
base measures, 2-2
checklist, 1-3
guidelines, 1-2

mpstat, 5-7

N

name duplication checks, 6-3
netstat, 5-7
NMS domain platforms

backing up, 3-9

P

performance
base measures, 2-6
checking for Solaris workstation, 5-7
checking for Windows PC, 5-5
gathering port inventory data, 4-3

performance statistics, 4-2
ping, 5-5
platform

base measures, 2-2
platforms

backing up, 3-9
checking Solaris performance, 5-7
checking Windows performance, 5-5

ports
checking for duplicate names, 6-4
gathering inventory, 4-3

prstat, 5-7

R

reachability
base measures, 2-7

restores
testing for database, 4-5

routine maintenance, 1-2

S

scalability
base measures, 2-5

See maintenance
services inventory, 6-2
software updates, 5-3
Solaris platform performance, 5-7
statistics

billing base measures, 2-7
performance, 4-2
verifying performance, 4-2

subscriber services
listing, 6-2

support
contact lists, 5-3
technical assistance, 1-3
updates, 5-3

synchronization
verifying for devices, 3-5

system files
collecting, 3-8

T

taskmgr, 5-5
technical assistance, 1-3
time and date

setting, 5-4
tracert, 5-5

U

user account lists
generating, 5-2

W

Windows platform performance, 5-5
IN-2 Alcatel 5620 Service Aware Manager, Release 3.0 R1
October 2005 95-5960-01-00-A



Customer documentation and product support

Technical support

Customer documentation

Product manuals and documentation updates are available through the Alcatel Support
Documentation and Software Download service at Alcatel.com. If you are a new user and
require access to this service, please contact your Alcatel sales representative.

Customer documentation feedback

http://www.alcatel.com/support/

http://www.alcatel.com/osds/

documentation.feedback@alcatel.com
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